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Preface 
 
The Xavier’s Resource Centre for the Visually Challenged (XRCVC) is happy to present this compilation of 
standards as culmination of its experience in the area of creating accessible reading material for blind and 
low vision persons. XRCVC has worked extensively over the years in creating accessible books through its 
robust volunteer system. We have endeavoured to create norms which are based on feedback from our 
diverse user base across age groups and content needs.  
 
What are presented here are standards for creating a master Word file which can be used to create DAISY 
and E-PUB Books and Braille Ready Files. The rational guiding this work has been to develop a more 
efficient accessible book process where endless duplication is reduced to the minimum and diverse user 
needs in terms of format can be served through a single streamlined process. 
 
This version 1.3 will be a continuously evolving work which will be regularly updated with new user 
experiences. We welcome feedback from you to help build this further. 
 
It needs to be seen not as an end process but rather as the beginning of a journey which will evolve based 
on constant usage and feedback. 

 

About XRCVC 
 
The XRCVC is a state of the art support and advocacy centre for persons with blindness and low vision. 
It is a department of the St. Xavier’s College, Mumbai, India, and works actively in the areas of providing 
Direct Support and Training Services to blind and low-vision persons, Awareness Generation and Advocacy 
Initiatives. 
 
The XRCVC works actively towards creating an inclusive environment both at the micro and the macro 
levels. Some of the key areas of its advocacy initiatives lie in the field of Print Access, Financial Access, 
Education Access and Independent Living. 
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SECTION 1 – HANDOUT ON ACCESSIBLE BOOK CREATION  
(MASTER COPY) 

 
 
The following accessible book formats can be created using this handout – 
 Braille Book 
 DAISY: Can be accessed with Screen Reader / DAISY-specific software 
 EPUB: Can be accessed across various devices using EPUB readers 
 MathML: Word file accessed with Screen Reader & Magnifier 
 
Basic Information: 
 
a. What is Braille? 
Braille is not a language but a script used by the blind. It is written within a six-dot unit called a Braille Cell, 
as shown below. 

 
Combinations of these dots make up the Braille alphabet. It also includes symbols to represent 
punctuation, mathematics and scientific characters, music, computer notation and foreign languages. 
 
b. What is a Screen Reader? 
A screen reader is a software that reads out screen content to allow those who are blind or low vision to 
use the computer / phone / tablet etc. 
 
c. What is a Screen Magnifier? 
A screen magnifier is a software that presents screen content in an enlarged manner. Such softwares also 
provide colour contrast options, mouse enhancements etc. to make the use of a computer / phone / tablet 
etc. easier for those with low vision. 
 
d. What is OCR? 
Unlike regular scanning procedures, Optical Character Recognition (OCR) technology allows the scanning of 
any printed text such that it becomes readable by synthetic speech. This helps to make hard copy materials 
accessible to persons who are blind or low vision, and who otherwise would rely on sighted assistance to 
read hard copy materials. 
 
e. What is DAISY? 
DAISY stands for Digital Accessible Information System. It enables the print-disabled population to access 
information almost as easily and efficiently just as a sighted person does while using a printed book. Other 
books are a single format but DAISY books are comprised of multiple file formats including text, audio etc. 
DAISY books may be accessed on computers, mobile phones or other special DAISY players. 
DAISY features include several navigation options like go to page, go to heading, go to bookmark etc. When 
you return to reading after a break, your book opens to where you stopped reading. Various magnification 
and speech options are available. 
 
f. What is EPUB? 
EPUB stands for Electronic Publishing. It is a file format with the extension .epub that can be downloaded 
and read on devices like smartphones, tablets, computers, or e-readers. 
 
g. What is MathML? 
Mathematical Markup Language or MathML is an application of XML for describing mathematical notations 
and capturing both its structure and content. Math Equations inserted in this method are recognised and 
readable by Screen Readers. 
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Book Creation Process at the XRCVC: 
 

I. Scanning 
 
Scan the complete book, cover to cover, for all text matter and relevant images that are to be inserted into 
the Word file. 
There are multiples tools available for OCR. There also exists many ways to use those tools, which depend 
on the format or type of the source file. Mentioned below are the methods to use for the different formats, 
so as to get the best possible outcome. 
 

Steps to follow for scanning using the ABBYY FineReader software… 
i. Double click on the ABBYY FineReader 14 (Corporate) icon on the Desktop. 

ii. Click on Scan option and then click on Scan to Microsoft Word, while ensuring the following 
options are maintained; OCR language: English, Colour: Colour, Preserve Formatting: Editable 
Copy, and the Keep Pictures and Keep headers and footers options checked and then click on 
Scan to Microsoft Word. 

iii. Place the page/pages on the scanning bed (the flat, glass surface) within the rulers. 
You can scan two pages at a time if they fit on the scanning bed. 
Most flatbed scanners have an adjustable lid that can be raised to allow magazines, books, and 
other thick objects to be scanned. However, you must always hold the book down, so as to not miss 
text that appears near the binding area. 

 
The following dialogue box opens up. Ensure all fields are selected as shown below: 
 

 
 
Scanner Settings: The resolution can be maintained at 300 dpi when the font size is normal and at 600 dpi 
when the font size of the print book is smaller than usual. Scanning mode: Color, Brightness: Automatic 
(scanner). 
Paper Settings: You may adjust the paper size, but that is not too necessary most times. 
Image Processing: Check all boxes to Correct page orientation, Split facing pages, Correct image 
resolution. 
Multi-Page Scanning is used with an Auto-feeder (see below). 
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iv. Click on Scan. 
v. Turn the page and click on Scan Pages. 

vi. Repeat this step to add consequent pages in the same file. Press Page Down to check the next 
page and Page Up to go to the previous. 

vii. Once the required pages have been scanned, click on the File Menu. 
viii. Click on Save As and select Microsoft Word Document (the .docx format). 

ix. Select the location you want to save the file in. 
x. Edit the File Name, as required – ideally the name of the book, keeping the extension. 

xi. Ensure that you create a single file for the whole book. 
xii. Click on Save. 

The default location where OCR files are saved is the last location used. 
 

When using the auto feeder option (HP ScanJet Pro 2500 f1 on PC1 and PC3)– 
i. Separating the pages. 

For a book: Tear apart each page in a book, ensuring smooth edges, you may use scissors to cut the 
side of the pages that were attached to the book. 
This requirement is met, so that the pages don’t jam the auto-feeder and disrupt the process. 
For Notes/xeroxed pages: Take the staples off and ensure smooth edges, as mentioned above. 

ii. Place the pages on the Document Feeder, (the correct side facing you/ so the top of the page goes in 
first) and adjust the width, accordingly. 
(Note: The OCR software will recognise text that is oriented in any direction.) 

iii. Select all fields as mentioned in the dialogue box above in step iii, with one adjustment. 
Under Multi-Page Scanning, check the Use automatic document feeder (ADF) option and the Duplex 
scanning option (to recognize text on both sides). 

iv. Click Scan. 
This is now, to be saved in the corresponding folder of the book. 

 

Saving, Cropping and Inserting Image Files 
Sometimes, images may not be recognised correctly and therefore, to avoid unnecessary duplication of 
efforts, the scanned images must be saved. 

i. This can be done by clicking on the Save Images… option under the File Menu or Ctrl+Alt+S. 
ii. Create a new folder, provide an appropriate file name and save as JPEG Colour. 
iii. Click on Save. 
This folder must then be moved to the main folder in PC2. 

 
Decorative borders, textboxes etc. are not to be considered when cropping images. 
However, images of people, animals etc. even if not linked to the text, are to be scanned for insertion in the 
files. 
Crop the image (Front and Back Cover included) that would need to be inserted into the Word file. This can 
be done in many ways. One simple ways is: 
 By using the Snipping Tool application (for an image or pdf file). 

i. Open the softcopy of the image (JPEG file), with the desired image displayed on the screen. 
ii. Press the Windows Key or the Start Menu and type ‘Snipping Tool’ and click on Enter. 
iii. Click on the New Snip button. 
iv. Drag the cursor around the area you want to capture. 
v. Right click and copy the image, then paste it at the appropriate line on the Word document. 
 

 Alternatively, you may also use the Microsoft Paint application (for an image file). 
i. Open the image file using Paint or open Paint and paste the mage. 
ii. Chick on the Select tool to select a part of the picture and click on Crop. 
iii. Save the image and paste it at the appropriate line on the Word document. 
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OCR for Hindi/Marathi or other regional language books using Google Drive OCR… 
Since ABBYY Fine Reader does not support any Indian languages, regional language books must be 
converted using OCR provided by Google Drive. 
This lets you convert images with text into text documents, either individually (.jpg, .png, and .gif files) or in 
multi-page PDF documents (.pdf). We however recommend processing individual images. 

Scan images of the book in a jpg format. You may use the auto feeder option on the HP ScanJet Pro 2500 
f1 scanners on PC1 and PC3 by following the steps given on the previous page. 
On completing scanning, 

i. Sign in to your Google Drive account. 
ii. Upload the image files or the folder as whole. 
iii. On uploading, right click on an image and Open with Google Docs. 

The OCR file (as Google Docs) opens in a new tab. The text then, must be copied to a Microsoft 
Word document and saved in the corresponding folder of the book. 

iv. Repeat step iii. for each image and keep adding to the Word file. 
 

Ensure that all the required images are saved in a folder named IMAGES. 
Hence, each book will have one IMAGES folder within its main book folder. 
 

 
II. Saving, Keeping & Naming Files and Folders 
 
Create a folder and give it an appropriate name as follows. Give the single Master Copy file the appropriate 
name as well. Capitalise as given in the book. This system of naming the file is followed when uploading 
books to the accessible online libraries. 
 
Class/Category, Book Name, Edition Number, Year of the Edition  
Example: 
Class 2 Rhythm in Writing, 2nd Edition, 2014 
Class 1 NEW LANDSCAPES PRIMARY GEOGRAPHY 1, 2015 
IMS General Awareness CET, 2013 
 
The single OCR Word file will have the same name as the folder. 
The name of the book will be decided as per the name that appears on the first page inside. 
 
Ensure that all the required images are saved in a folder named IMAGES. 
Hence, each book will have one IMAGES folder within its main book folder. 
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III. Editing / Proofreading / Formatting Stages: 
 
After the scanning, the file that you work on will be used to make a Braille hard copy book, the DAISY book, 
the EPUB and the MathML book, so that the same book will be ready to share with different people 
depending on their needs and preferences. 
 
For ease of process, we have classified these as three types of Word files that will need to be created, as 
follows: 

 
 
A. Word File: 

This file is the master copy and will involve almost all the editing, proofreading and formatting; and is 
the base which will be used to create the below three files. 
 

B. Braille Ready Word File: 
This file will involve editing as required for Braille printouts using a Microsoft Word Add-in called 
SWIFT; and will be used for translation into Literary Braille (text content) or Nemeth Braille (Maths 
content) with the help of a Braille translation software. 
 

C. Digital Accessible Information System (DAISY) 
This file will be created with the help of a DAISY conversion software. 
 

D. Electronic Publishing (EPUB) 
This file will be created with the help of an EPUB conversion software. 
 

E. MathML 
This file is created using a MathType Equation Editor used for describing mathematical and scientific 
content. 

  

Word File 

Braille Ready 
Word File 

DAISY EPUB MathML 
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A. Master Copy Word File 
 

1. Copy-Paste – Unformat 
 
 Why? 
 
The OCR scanning throws up errors due to different fonts, formatting, images etc. in the hard copy that is 
scanned. The first step is to clear this text and directly remove unwanted formatting fluctuations by saving 
all text in unformatted style. Such unformatting is necessary for a well-made accessible book. 
 
 How to? 
 
In the file that you are working, follow this process: 
i. Press Ctrl+A (to select all). 

ii. Press Ctrl+X (to cut what is selected). 
iii. Press Ctrl+V (to paste what is cut). 
iv. Immediately after pasting, at the bottom right side of the last line of what is pasted, click on the  

symbol next to (Ctrl). 

v. Click on the option  i.e. the Merge Formatting. 
 
Ensure that the Font is standard Calibri, the Font size ideally maintained at 11 and that everything is 
aligned as in the Physical book. 
 

i. Press Ctrl+A. 
ii. Select Font Calibri, Font Size 11. 

iii. To align lines as in the print book, keep your cursor on the line and use the text align buttons 

 under the Paragraph group in the Home tab. 
Do not use multiple tabs or spaces to achieve this. 
 
NOTE: The font size may have to be decreased at times in order to fit the contents of a print page onto a 
Word page. 
 
 

2. Cleaning up extra Spaces, Tabs, Enters etc. 
 
 Why? 
 
Unformatting of text by following the process above is only the first step of the clean-up. Next, you have to 
pay closer attention to look into details. 
There may be multiple Spaces where only one is required; some Tabs may appear as Spaces. The OCR 
process may recognise the Spaces between lines as Enters etc. All this should be cleaned up as explained 
below. 
 
 How to? 
 
To begin the editing of the unformatted text, you first have to remove unwanted Tabs as follows: 
i. Press Ctrl+Home (to go to the beginning of the file). 

ii. Press Ctrl+H (to open the Find and Replace dialog box). 
iii. In the Find what: field, type ^t (^t is the code to find a Tab). 
iv. In the Replace with: field, type a single Space (so that a single Space is used instead of a Tab). 
v. Click the Replace All button (to make the required changes in the entire file at once) 

 
Similarly, to remove unwanted Spaces, you will follow similar steps: 
i. Press Ctrl+Home (to go to the beginning of the file). 

ii. Press Ctrl+H (to open the Find and Replace dialog box). 
iii. In the Find what: field, type two Spaces (because you have to get rid of double spacing). 
iv. In the Replace with: field, type a single space (so that a single Space is used instead of a two Spaces). 



XRCVC's Accessible Book Production Standards 1.3 

 

v. Click the Replace All button (to make the required changes in the entire file at once) 
 
Note: 
In case, there are three Spaces at any position in the document, logically, they will be reduced to 2. So 
you would need to remove that one extra space using the same steps again. Hence, it is advised to 
click the Replace All button multiple times, till it informs you that it made 0 replacements. 

 
A common mistake occurs while spacing punctuation marks. Most punctuation marks (, . ; : ? !) don’t 
require a space before, but after. A single space is left after all punctuation marks if it is followed by 
words. 

 
Likewise, to remove unwanted Extra Blank Lines: 
i. Press Ctrl+Home (to go to the beginning of the file). 
ii. Press Ctrl+H (to open the Find and Replace dialog box). 
iii. In the Find what: field, type ^p^p (^p is the code to find a Paragraph Mark. Therefore, ^p twice will 

find all the extra blank lines). 
iv. In the Replace with: field, type ^p (so that all extra blank lines are removed). 
v. Click the Replace All button (to make the required changes in the entire file at once) 
 
Most of the errors mentioned above may be difficult to spot since they all appear blank. 
Therefore, you should switch on the option for other hidden formatting symbols: 
i. In the Ribbon / Menu, go to the Home tab. 

ii. Under the Paragraph submenu, click on the  symbol i.e. the Show/Hide option. 
When this is switched on, the symbols are shown as follows… 

Spaces are represented by  

Tabs are represented by  

Enters are represented by  
 

When you notice  at the end of a line even if it is not the end of a paragraph, make sure to replace the 
incorrectly recognised character (Enter) by the correct one (Space). 
To do this, you may either: 

i. Position your cursor at the end of the line where  appears. 
ii. Press the Delete button. 

iii. Now, press the Spacebar. 
OR 

i. Position your cursor at the beginning of the line below the  symbol. 
ii. Press the Backspace button. 

iii. Now, press the Spacebar. 
 
Another way to spot this inaccuracy is by looking out for the errors recognised by MS Word itself. 
Whenever you notice a green or red wavy underline… 
i. Position the cursor in the middle of the relevant word / phrase. 

ii. Right-click to look for correct options. 
OR 
i. In the Ribbon / Menu, go to the Review tab. 

ii. Under the Proofing submenu, click on the Spelling & Grammar option. 
 
The example below shows errors like an incorrectly recognised Enter and Tab within a raw OCR’d file, which 
need to be changed. 
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Below is the corrected version of the above example. 

 
 
 

3. Inserting blank lines (enter) 
Extra Blank Lines (Enter) to be used only as follows. 
- Before and After the Chapter name line 
- Before and After a Picture 
- Before and After a Table 
- Before beginning a Text box/Sidebar and After ending a Text box/Sidebar 
- Only Before Section Headings and Subheadings (NOT AFTER) 
- In case of an overlap of line, always leave a single line. Never leave double lines 
 
 

4. Inserting Copyright Notice & Cover Pages Info 
 
Insert the Metadata, Copyright Notice and Disclaimer from the separate file, as the first page of the book. 
This page, along with the front and back covers are to remain unnumbered. 
 
Use Ctrl+Enter to insert a page break before the main text. 
Do not press Enter multiple times to go to a new page. 
 
Therefore, 
Page 1 = Copyright Notice 
Page 2 onwards = Textbook Content beginning with the Front Cover 
 
On a new page, after the Copyright Notice, the whole scan of the front cover will be inserted as an image 
with appropriate Alt Text (and Image Description) for the same. Image Description may be written below 
the image in case of long Alt-Text. In the Alt-Text tagged to the image, mention “Picture: Front cover of the 
book as described below.”) Ensure that the Alt Text explains the placement of different aspects on the 
page. 
 

Front Cover begin 
MADHUBAN ® (logo) 
Revised 
Transitions 
HISTORY AND CIVICS 5 
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Front Cover end 
 
Image description begin 
The page has a collage of the following images on it: 
India gate lit up at night, the main façade and dome of St. Peter's Basilica. 
Below is a photograph of Kailash Satyarthi, and another of two policemen checking baggage at an airport. 
In the bottom centre is a photograph of The Colosseum. The bottom right has a photograph of a lady using 
an electronic voting machine and below is a photograph of children in school uniforms eating while seated 
on the floor in rows. 
Image description end 

(Check the Alt-text for the above front cover by placing your mouse pointer over the image.) 
 
 

5. Inserting Page Numbers 
 
 Why? 
 
Most often, teachers in schools ask students to "Open to page __." When a blind or low vision student 
studies in an inclusive school, these numbers will not match the Braille pages or the Accessible E-book file 
pages. Hence, you need to insert page numbers as per the sighted print textbook so that the visually 
impaired student can literally, 'be on the same page' as the rest of the class.  
 
 How to? 
 
The content of a print page must be fitted within one Word page and separated with the next and previous 
with a page break. To achieve the following; 
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- the size of the page can be increased in Word (Under the Page Layout tab, choose a bigger paper 
size under Size in the Page Setup group) 

- the margins of the page can be widened 
- the font size of the text can also be decreased in case the text still spills onto the next page. 

 
Insert page numbers as footers using the Page Number option in the Header & Footer group under the 
Insert tab. Select the third option – Plain Number 3. 
 

 
 
Section Breaks: 
Retain the page numbering as it is in the print book. If the book contains page numbering of the type i, ii, 

iii… or A, B, C… or 1, 2, 3… etc, retain them in your Word file. For Hindi/Marathi books, you may use १, २, ३… 

etc. Page numbers should correspond to the relevant content. 
Thus, each section might have a different header or footer with different page numbers. 
To achieve this, divide you r document into sections, those that have the same page numbers. For example; 
pages numbered in Roman numerals (I, II, III… or i, ii, iii…) will be sectioned by adding a Section Break. 

i. Under Page Layout tab, go to the Page Setup group and click on Breaks. 
ii. Then select Next Page under Section Breaks in the dropdown list. 

 
After these Section Breaks are added, format the page numbers for every section separately. 

iii. Go to the Format Page Numbers option under Page Number in the Header & Footer group as 
shown below and select the appropriate number format. 

 
 To leave pages unnumbered, for example, the copyright and cover pages, a section break would be 

required. 
1. Then, on the first page of the section from which you want to remove page numbers, double-

click the header or footer to open it. 
Note: The sections in your document are numbered. When you edit a header, you will see a 
label that says Header -Section x- or Footer -Section #-, as well as information about whether 
that section is linked to the previous section. 

2. Select the page number and delete it. All page numbers in that section will also be deleted. 
If this doesn't work, on the Design tab, in the Navigation group, make sure Link to Previous is 
not selected. 

 

 For initial and final content present on pages that are not part of chapters, use these words 
appropriately. 
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Example: 
Front Cover begin/end 
In Hindi, follow this:  

सामने का कवर शुरू/अंत 
In Marathi, follow this:  

मुखपृष्ठ सुरू/समाप्त 
 
Inner Front Cover begin/end 
In Hindi, follow this:  

भीतर का सामन ेकवर शुरू/अंत 
In Marathi, follow this:  

आत मुखपृष्ठ सुरू/समाप्त 
 
Inner Back Cover begin/end 
In Hindi, follow this:  

भीतर का पीछे कवर शुरू/अंत 
In Marathi, follow this:  

आत मलपषृ्ठ सुरू/समाप्त 
 
Back Cover begin/end 
In Hindi, follow this:  

पीछे का कवर शुरू/अंत 
In Marathi, follow this:  

मलपृष्ठ सुरू/समाप्त 
 
Since these pages are to remain unnumbered, add a section break after inner front cover. 
Under Page Layout tab, go to the Page Setup group and click on Breaks. Then select Next Page under 
Section Breaks in the dropdown list. 
 

 Add the whole Front and Back covers as images, with text on it written outside the Description box, 
and Alt-Text and Image Description (written below in case of long description) focusing on only the 
images on the page. 

 In case you come across a new page which is blank (no text or images), you need to insert the 
following statement in brackets on the relevant page. 

 
For books in English: 
(This is a blank page.) 
For books in Hindi: 

(यह खाली पषृ्ठ है।) 
For books in Marathi: 

(हे रिकाम पान आहे.) 

 
 

6. Handling Images 
 
 Why? 
 
All books are made considering that either a blind or a low vision student might use it. Hence, all images 
from the textbook will be scanned, cropped, and added to the Master Copy file. 
Decorative borders, textboxes etc. are not to be considered while inserting images. 
However, images of people, animals etc. even if not linked to the text, are inserted in the Master Copy. All 
Tree Diagrams, Flowcharts, Crosswords, Word Puzzles, Mazes etc. will be treated as images. 
Image Description (Alt Text) needs to be added for every image inserted, as far as possible. 
However, tactile diagrams are to be created only for relevant diagrams, as decided by the staff in charge. 
 
 How to? 
 



XRCVC's Accessible Book Production Standards 1.3 

 

i. Although ABBYY Fine Reader recognises and inserts images in the Word file, they may not be 
placed on the desired line. 
Position the image either before or after the relevant text content that is connected to the picture, 
but never in the middle of a paragraph. 

ii. Double-click on the image. (This opens the Format tab in the Menu bar.) 

iii. Click on the  symbol i.e. the Crop option. 
iv. Always crop the image only from the 4 corners - i.e. bottom-right, bottom-left, top-right or top-left. 

This is done so that the proportion of the image is maintained. 
v. Crop the image as close to the required portion as possible, without cutting off any relevant lines. 

vi. Sometimes, captions appear below / above images. Make sure to exclude the captions of all images 
as part of the picture to be pasted. The caption will be written above the image inserted, as 
demonstrated later. 

vii. Paste the image in the document with a blank line before the caption (if any) and one after the 
image. 

viii. When separate images are found next to each other, place them one below the other in the Master 
Copy file. 

ix. When there are images in Match the Column questions, use the same format of placing images one 
below the other. Use additional numbering, as required. 

x. Handling Flowcharts: 
When flowcharts with text or images are present, crop the whole flowchart as a single image with 
Alt-Text and Image Description written below it. 
The Alt-Text will read — Picture: Image of a Flowchart as described below. 
 

Interdependence in the environment 

 
Image Description begin 
Flowchart showing an arrow pointing from a drawing of microorganisms and fungi shaped like 
mushrooms, etc. to the word ‘Nutrients’. Another arrow from ‘Nutrients’ points to a drawing of a 
garden with trees and flowering plants, with the sun shining in the background labelled ‘Plants’. An 
arrow from here then points to a drawing of a Zebra labelled ‘Plant-eating animals’. From the zebra 
is an arrow pointing to a Lion labelled ‘Flesh-eating animals’. From the Lion is an arrow pointing 
back at the microorganisms and fungi, indicating the cycle continues. 
Image Description end 

(Check the Alt-text for the above image by placing your mouse pointer over it.) 
 

xi. Handling Tree Diagrams: 
Tree Diagrams are also to be added as an image with appropriate Alt-Text and Image Description. 
The Alt-Text will read — Picture: Tree Diagram as described below. 
Use the Multilevel List in the Paragraph Group under Image Description to show hierarchy. 
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Image Description begin 
Tree diagram showing 
1. Public Services 

1.1. Electricity 
1.1.1.  Switch off lights, fans and the television when you leave the room 
1.1.2.  Do not use the air conditioner unless necessary 
1.1.3.  Use LED lights 

 
1.2. Water 

1.2.1.  Do not leave taps open while brushing your teeth 
1.2.2.  Fill water in buckets for bathing and washing clothes 
1.2.3.  Repair leaking taps 
1.2.4.  Water plants with used water 

 
1.3. Public Transport 

1.3.1.  Not litter buses, trains, etc. 
1.3.2.  Not damage the seats 
1.3.3.  Take pride in our public transport system 

 
1.4. School 

1.4.1.  Citizens should involve themselves in making every Indian educated 
Image Description end 
(Check the Alt-text for the above image by placing your mouse pointer over it.) 
 
 
Inserting Alt Text after pasting the image… 
 

i. Select the image and right-click to select Format Picture as shown below. 
ii. In the Format Picture dialog box, choose Alt Text. 

iii. Add the image description in the Description box.  

iv. Begin all image descriptions with “Picture: ”  In Hindi/Marathi, follow this: चित्र: 
 
For images which already have a caption, the caption is written below the picture after the image is 
cropped and added to the document. 

v. Close the dialog box. 
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Keep in mind the following points when writing the Alt Text (description of an image). 
 Alt-Text shouldn’t be a sentence, but a statement. 
 Give detailed explanation which would aid the lesson. 
 Read the text around the images to make sure you are using the same terms as the text. 
 If the image description is going to be word to word (or only slightly different from the caption already 

given, there is no need of the description to follow the caption. 
Wrong Example, 
Fig. 9.3 Main screen of Tux Paint 
Alt-Text: Picture: Main screen of Tux Paint 

 Read and understand the context of the image. As far as possible, the description of the image should 
not readily give the child the answer which he/she is expected to find out. In such cases, consider 
tactile diagrams. 

Example, if in the textbook the student is required to identify a shape; the image description should 
be: 
Picture: A shape 
(Refer to tactile diagram.) 
and not ‘Picture: a square’. 

 Sometimes, captions appear below / above images. Insert the caption as part of the Alt Text, as 
mentioned under iii. 

 
 
Example of a short Image Description inserted as Alt-Text in the Description box— 
 

Coins and paper notes make up the Indian currency. 

 
(Check the Alt-text for the above image by placing your mouse pointer over it.) 
 
 
Examples of long Image Descriptions being added under the image— 

Caption 

Caption 
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When the Alt-Text gets too long (more than one statement), it shouldn’t be written in the Description box under Alt-
Text. This is because you cannot navigate through the text inserted as Alt-Text, if one wishes to. 
In this case, it is written below the image with the words Image Description begin before it on a new line and end with 
Image Description end after it, also on a new line. 
The Description box, however shouldn’t be left blank and you must add a short one sentence Alt-Text mentioning that 
the image description is given below/refer. 
Example,  
Picture: Graph showing … as described below. 

 
EXAMPLE 1: 
Here is an example of an image in the Computer textbook. 
When describing this image, use the words tab, group etc. as used in the text. 
 

 
 

Fig. 4.1 Selecting the Cut option 

 
Image Description begin 
The Paint window with a yellow star with orange borders with its top half selected; and arrows pointing to 
the required areas: 
Foreground colour (orange) 
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Background colour (red); 
with instructions to: 
1. Click Select 
2. Select the area of the drawing you want to cut 
3. Click the ‘Cut’ option 
Image Description end 

(Check the Alt-text for the above image by placing your mouse pointer over it.) 
 
EXAMPLE 2: 

 
Image Description begin 
BOY: Hi Toggle, can you teach me a little about computers? 
COMPUTER: Oh sure, Goggle! Come I’ll introduce you to the parts of a computer and to the start and shut 
down procedures. 
Image Description end 

(Check the Alt-text for the above image by placing your mouse pointer over it.) 
 
EXAMPLE 3: 
If a poem / dialog (literal text) is placed on an image like in the example below, it should be inserted as text 
before the image. The image must then be cropped and Alt-Text provided. Provide Image Description if the 
Alt-Text gets too long to insert in the description box. 
 

Loveliest of trees, the cherry now 
Is hung with bloom along the bough, 
And stands about the woodland ride 
Wearing white for Eastertide. 
 
Now, of my threescore years and ten, 
Twenty will not come again, 
And take from seventy springs a score, 
It only leaves me fifty more. 
 
And since to look at things in bloom 
Fifty springs are little room, 
About the woodlands I will go 
To see the cherry hung with snow. 
 
—A.E. Houseman 
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(Check the Alt-text for the above image by placing your mouse pointer over it.) 
 
 
Also check for Style Guides at http://diagramcenter.org/table-of-contents-2.html 
While you can use your judgement to create Alternative Text / Image Description, do run your ideas by the 
XRCVC staff who has assigned the work to you. As the nature of description is very contextual and may be 
different in different situations, highlight in yellow all the changes you have made in the file for easy future 
reference. Check with the relevant staff whether description is required in detail, or tactile diagram is to be 
created. 
 
Note: 
The Alt Text will be written in the relevant language – Hindi Alt Text for Hindi books, Marathi Alt Text for 
Marathi books. 
 
NOTE FOR POINTS 7 to 18 
Many a time, reference text, exercises & activities in the sighted print book may not be accessible if left as 
they are in the Master Copy book used by the blind or low vision student. Hence, one needs to use their 
discernment and edits should be made accordingly. 
Especially because textbooks are typically very visual and pictorial along with providing Image Descriptions 
as well Tactile Diagram Supplements with the accessible content, certain modifications to the text may also 
be required.  These adaptations need to be considered and will differ each time in each context. Always 
check all changes. 
 
Here are a few examples of adaptations typically made to textbook materials when converting them to 
accessible books. 
 
 

7. Replacing Visual Words 
(NOT APPLICABLE to books from Class 11 onwards) 

http://diagramcenter.org/table-of-contents-2.html
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 Change ‘Fill in the boxes / grid etc…’ to Fill in the blanks. 
 

 Questions like ‘Fill in the blanks with the words given in the box / cloud / tree’ etc. should be 
changed to Fill in the blanks with the words given in brackets. 
Note: 
Here we use round brackets / parentheses. 

 

 Since we will be using bold instead of colour, in cases where the text says, ‘Refer to the words in 
colour.’, we put each relevant word / phrase in Bold and change the text colour to Blue (from the 
Standard Colors list under Font Color). The text will have to be edited accordingly as Look at the 
words in blue and bold. 

 In Hindi text, make the change using the words below: 

Example: रंगीन छपे शब्दों से सववनाम चुनो| 

Master Copy: मोठे औि नील ेछप ेशब्दों से सर्वनाम चुनो| 

 

 
 
NOTE: 
Since, all the above are changes we make to the content of the book, it is necessary to add a Producer’s 
Note before the section that has been changed. 
Producer’s Note: The section below has been modified for accessibility. 
 
 

8. Handling Visual Marks 
(NOT APPLICABLE to books from Class 11 onwards) 

 
Also, where answers have been Circled / Crossed / Boxed / Struck through or for visual lines showing 
answers of Match the Columns, in order for the sighted student to know; this may be represented in simple 
text as shown below. 
 
Example 1: 
a. true – beautiful bad         same 
 
Master Copy: 
Ans. true - false 
 
Example 2: 

false 
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Common Nouns Proper Nouns 

1. country a. Gateway of India 

2. city b. Shikhar Dhawan 

3. building c. Ramayana 

4. cricketer d. Japan 

5. car e. Tokyo 

6. river f. Nanda Devi 

7. book g. Chevrolet 

8. mountain peak h. Godavari 

 
Ans.: 1. - d 
 
Example 3: 

 
 

उत्तर: लालची 
 
NOTE: 
This section also requires a Producer’s note to be added, before the section that has been changed. 
Producer’s Note: The section below has been modified for accessibility. 
 
 

9. Handling Cross & Tick symbol” 
When you come across any section which has cross and tick mark in it, crop it as an image and add alt text – "cross 
mark" & "tick mark" respectively. 
Example: 
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10. Retaining Visual Instructions 
 

 When questions mention to draw, do not change the question, since the visually impaired child 
should have practice in drawing as well. 

 You do not need to alter statements like, ‘Look at the words below.’ The child will be looking and 
reading with their fingers and/or ears. 

 Activities involving colouring shouldn’t be substituted or removed. 
A blind child can be expected to colour within tangible boundaries on tactile diagrams provided. If 
the activity / exercise can be made more interesting / appealing to the child by colouring, the 
question should be kept as it is and an appropriately created tactile diagram should be provided for 
the same. 
Even within e-copies, shading, highlighting or a font colour change may be applied to the required 
text once selected. 

 
 

11. Additional Numbering 
 
Some books may not include question numbers as the sighted students are expected to fill in their answers 
in the textbook / workbook / worksheet itself. Questions of this kind would need to be numbered since the 
student using the Braille book would be answering these questions on a separate sheet and inserting 
question numbers will help the student link them to the original questions. 
 

 
 
Note: 
If question numbers are already mentioned, do not change them. 
 
In exercises, when a student may be required to pick out answers from a list, change all symbolic bullets to 
numbers instead. 
 
Example: 
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Master Copy: 
1. While speaking, we often make some very common mistakes. In each pair, one sentence is incorrect. 

Do you know which one? 
a. Today morning I got up at 6 o'clock. 
b. This morning I got up at 6 o'clock. 

 

 For Match the Columns: 
In case of information in columns without headings, give names Column A and Column B. 
All items in all columns should be numbered so that the user does not have to write the entire word / 
phrase / sentence in the answer sheet. 
Depending on the original text in the sighted print, if one of these sequences is already used in one column, 
choose from another series for the remaining columns. 
1. 2. 3. …, a. b. c. …, i. ii. iii. …, A. B. C. … etc. 
 

 For questions without answer options i.e. not MCQs 
First level – A. B. C. or I. II. III.  (Based on previous numbering within the chapters of the book) 
Second level – 1. 2. 3. 
Third Level – a. b. c. 
Fourth Level- i., ii., iii. 

 
 

 For questions with answer options i.e. MCQs 
First level – 1. 2. 3. 
Second level (options)– a. , b., c.  

 
NOTE: 
This section also requires a Producer’s note to be added, before the section that has been changed. 
Producer’s Note: The section below has been modified for accessibility. 
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12. Multilevel lists 

 Why & How? 
 
Lists of words & phrases are shown in different ways at different times in sighted print textbooks. However, 
to maintain as much uniformity as possible, and so that the visually impaired user does not get confused, 
you will do the following: 
 
Multiple Choice Questions (MCQs): Applies to options given for each question 
 

 Numbered Lists 
They are to be arranged one below the other. The list with numbering should be generated using the auto 
number feature of the MS Word. Manual numbering should be avoided. To match the numbering format as 
in the print book, you can customise it by selecting the Define New Multilevel List option under the 
Paragraph group. 
 
Example 1: 

 
 
Master Copy: 

C. Speak out the degrees of comparison of these words: (for oral practice) 
1. wide 
2. soft 
3. lazy 
4. sweet 
5. cheerful 

 
 

 Bulleted Lists  
(FOR BULLETED LISTS, follow rules as per those given in point 11 below.) 
 
Example 2: 

 
 
Master Copy: 
 
2. before the names of things that are only one of their kind: 

 the sky 

 the earth 

 the moon 
 

 MCQ Bulleted Lists 
In exercises, when a student may be required to pick out answers from a list, change all symbolic bullets to 
numbers instead. (Follow the numbering rules as per Point 9 MCQ section) 
 
Example: 
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Master Copy: 
1. While speaking, we often make some very common mistakes. In each pair, one sentence is incorrect. 

Do you know which one? 
a. Today morning I got up at 6 o'clock. 
b. This morning I got up at 6 o'clock. 

 
 MCQ Non Bulleted Lists 

When non-bulleted or non-numbered options are presented without brackets and commas, place them 
horizontally in a line in round brackets, separated by a comma, and a space. 
 
Example 1: 

 
 
Master Copy: 
K. See the pattern and then fill in the blanks with the following words: 
(mine, ours, yours, his, hers, theirs) 
 
 
Example 2: 

 
 
Master Copy: 

सकमवक व अकमवक क्रियाओं को छााँटकर अलग-अलग लललखए। 

(डरना, हाँसना, खाना, सुनाना, तोड़ना, जागना, रोना, सींचना, बुलाना, चमकना) 
 

 If non-numbered options are given in brackets, next to each other, with commas or slashes keep as 
is. 

 

 
 



XRCVC's Accessible Book Production Standards 1.3 

 

 
 

 In case options are separated by commas or slashes, but not put within brackets, then add round 
brackets around the relevant words or phrases. 

 
Example: 

 
 

Master Copy: 
1. January is the (colder/coldest) month of the year. 
2. Mumbai is (big/bigger) than Delhi. 
 
 

13. Handling Bullets and Sub-bullets 
 
 Why & How? 
 
The various visual bullets typically inserted in Word can be made accessible to be read out by the Screen 
Reader. These can then, also be transliterated correctly in Braille using the SWIFT Add-in. 
In Braille, the convention is to use dots 2,5 twice i.e. two hyphens (--) before a bulleted point, with no space 
before and after. 
 
Bulleted list 
The bulleted list should be prepared using the Word Bullets feature. Built-in styles should always be used to 
create the unordered lists. 
 
Example: 
 apple 
 mango 

 
Sub-bullets 
 Class 5 ICSE Guided Mathematics 

 Large Numbers 
 Understanding Numbers Better 

 Worksheet 1 
 International Place Value System 

 Worksheet 2 
 
Hence, Bullets with sub-bullets are treated similar to Tree Diagrams numbering listed in point 9. 
 
Note: It is important that you insert these bullets using the automated bullets feature in Word. 
 
 

14. Handling Table of Contents 
 
 Why? 
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The Table of Contents/Index page of the book that usually appears in the first few pages is to be created by 
adding an auto generated Table of Contents template. This synchronises the pages of the accessible book 
with pages of the print book. 
 
 How to? 
 

i. Position your cursor on the line that the Table of Content appears in the print book. 
ii. In the Ribbon / Menu, go to the Reference tab. 
iii. Click on the Table of Contents dropdown & select either Automatic Table 1 or Automatic Table 2. 

(The only difference between the two is that Automatic Table 1 is labelled ‘Contents’ and 
Automatic Table 2 is labelled ‘Table of Contents’.) 

 
 

15. Handling Tables 
 
 Why? 
 
One can easily navigate through tabular information in an E-Copy book using a Screen Reader which 
announces the Column number & Row number & the relevant information. On entering a table, the 
software gives an overview of the total number of columns & rows. 
 
 How to? 
 
To insert information in tables: 

iv. In the Ribbon / Menu, go to the Insert tab. 
v. Click on the Table dropdown & select the number of rows and columns from the grid, as required. 
vi. Click on the last needed cell at the bottom-right. 
vii. Click on the OK button. 

OR… replace steps ii & iii with the following. 
ii. Click on the Table dropdown. 
iii. Click on the Insert Table option which will open a dialog box where you enter the Number of 

Columns & Number of Rows required. 
 
When a table spans over two or more pages; 

- the header row must be repeated on every page. To achieve the following, go to Table Properties, 
and check the ‘Repeat as header row at the top of each page’ option under Row tab. 

 

 
 
It is IMPORTANT that you do not try to achieve this manually. 
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- For the same purpose, the table should be one single continuous table and must not contain page 
breaks. 

- Even though, this isn’t a significant change, we will add a Producer’s note stating that this section is 
modified for accessibility. 

- a Producer’s note stating that the tables spans from pages 56-58, for example, will also be added. 
 
Use tables for all topics where one needs to read the columnar information line wise. 
 
Here are some examples of where tables are to be inserted: 
 

 Subject & Predicate 
Example: 

 
 
Master Copy: 

 Subject Predicate 

1. Birds fly 

2. The sun rises 

3. The moon shines at night 

 
 Correct & Incorrect statements 

Example: 

 
 
Master Copy: 
Use the words tell, told, say and said correctly: 
 

What we should not say What we should say 

I will tell to the teacher that I cannot do this sum. I will tell the teacher that I cannot do this sum. 

My mother told to me to finish my homework. My mother told me to finish my homework. 

 
 

 Bullets & sub-bullets will be auto-nested in the same cell. 
 
Example: 

 
 
Master Copy: 

Unit Comprehension Working with 
Words 

Learning about 
Language 

Listening & 
Speaking 

Composition / 
Activity 

1. Message 
in a Bottle 

A short tale with 
plenty of conversation 

 Questions 

 Recall: true or false 

 Anagrams 

 Spelling 

 Sentence 
completion 

 Nouns 

 Sequencing 

 Question 
tags 

 Composing a 
paragraph 
using the 
words given 
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 Reference to 
context 

 
 

16. Handling Fill in the Blanks 
 
 Why & How? 
 
For creation of Braille books, a blank (that needs to be filled) is conventionally represented by dots 3,6 
thrice. The sighted print hyphen (-) translates to the required dots. 
 

 Fill in the blanks within sentences 
Hence, all blanks, blank boxes, dotted blank lines, dashes, underlines…etc. will be replaced by 3 hyphens 
with a space before and after them ( --- ). 
 
Example: 
Master Copy: 
B. Fill in the blanks using the words given below. 
(caterpillar, embryo, chick, lifespan, spawns) 
1. When a baby bird comes out of an egg, it is called a ---. 
2. --- are the egg clusters laid by female frogs. 
 

 Within a table 
Blank cells of a table will be retained as blank cells. Hence, there is no need of entering 3 hyphens to 
represent a blank within a cell. 
In case the sighted book shows a few dots or a question mark, only then will we keep as is in the sighted 
book. 
 

 Single letter blanks as part of work puzzles and pyramids 
When asked to fill in single letters or numbers as part of word puzzles or word pyramids etc. Use only a 
single hyphen for each character (either letter or number), with no space before or after. 
 
Example 1: 
 

 
 
Master Copy: 
Fill in the vowels in the following verbs. 
1. D-NC- 
2. --T 
 
Example 2: 
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Master Copy: 
G- 
G-- 
G--- 
G---- 
G----- 
G------ 
G------- 
G-------- 
G--------- 
 

 Fill in the blank for entire lines 
In Handwriting books / Worksheets etc., in case of an entire line of dots, or dashes, or a number of blank 
lines, we ignore the blank lines; and only put down the questions / statements one below the other. Hence, 
there will be no representation of blank lines. 
 
 

17. Handling Text Boxes and Sidebars 
 
 Why? 
 
At times, information is presented in boxes only for visual effect. For example, at the beginning of a lesson 
etc. Such content can be typed in an E-Book with just the heading / subheading (and no representation of a 
box). 
However, there may be some Facts, or Quick Tips, or Did You Know? kind of information that may appear 
at different places in the middle of the main text content with or without consistency. These are to be 
treated as Text Boxes. 
Sometimes you may come across, text in vertical boxes along the content of the page, these are 
distinguished separately as Sidebars. 
 
 How to? 
 
In order to distinguish the text within and outside the boxes, do the following. 
To insert information in a box: 
i. On the new line, type Text Box begins. 

ii. Insert all text that has to go within the box, as required. 
iii. On the next line, type Text Box ends. 

 
Example: 
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Master Copy: 
Text Box begin 
In this Chapter 
--What is a Computer? 
--What is a Computer made of? 
Text Box end 
 
For Hindi, follow this: 

पाठ बॉक्स शरुू 
… 

पाठ बॉक्स अतं 
 
For Marathi, follow this: 

मजकूर बॉक्स सरुू 
… 

मजकूर बॉक्स शवेट 
 
 
Similarly, to insert information as a Sidebar: 
i. On a new line, type Sidebar begin. 

ii. Insert all text appearing in the sidebar. 
iii. On the next line, type Sidebar end. 

 
Master Copy: 
Sidebar begin 
… 
Sidebar end 
 
For Hindi, follow this: 

साइडबार शरुू 
… 

साइडबार अतं 
 
For Marathi, follow this: 

साइडबार सरुू 
… 

साइडबार शवेट 
 
 

18. Handling Bold, Italics, Underline 
 
 Why? 
 

To allow low vision students and those with other print disabilities have an almost duplicate copy of the 
sighted print, you would need to apply Bold, Italics, Underline as per the sighted print book. 
Font Colours, however, will not be replicated. All the text matter will be Black (except the Heading Levels 
where you will maintain the default colour). 
To draw attention to words that are represented by colour, make the relevant text bold change the font 
colour to blue instead. (Explained in point 6.) 
 
 How to? 
 

When you unformat the entire OCR scanned file, most times all Bold, Italics, and Underline get recognised 
automatically. Wherever required, apply Bold, Italics, and Underline to words / phrases / paragraphs etc. as 
follows: 

i. Select the relevant words / phrases / paragraphs. 
ii. Press Ctrl+B (for Bold) and/or Ctrl+I (for Italics) and/or Ctrl+U (for Underline). 
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19. Footnotes 
 
Insert all footnotes in the text as footnotes in the Word file. 
 
To insert footnotes: 

i. In the Ribbon / Menu, go to the References tab. 
ii. Click on the Insert Footnote button. 
iii. The focus / cursor automatically jumps to the bottom of the page, where you can type out the 

footnote as seen in the sighted print text. 
 
 

20. Handling Headings & Subheadings 
 
 Why? 
 
This is done so that the student reading an E-Book can navigate through the Word file by jumping headings, 
sub headings and page numbers just like one would when reading a hardcopy print book. Applying Heading 
styles in Microsoft Word will also result in generating a Table of Contents (TOC) section automatically in the 
Duxbury Braille Translator. 
 
 How to? 
 
This can be done by selecting the Heading Levels in the Menu ribbon in Word as shown here. Alternatively, 
you can use Alt+Ctrl+1 for Heading 1, Alt+Ctrl+2 for Heading 2, etc. or Ctrl+Shift+S to Apply Styles – 
 

 
 

 If the book is divided into Parts / Units… 
Heading 1: Title of the Book 
Heading 2: Parts / Units /Section/Modules/ Copyright / Preface / Foreword / Acknowledgements / 
Messages by Editor / About the Author / Contents/Index of words/Glossary 
Heading 3: Chapter Number & Name/Worksheets/Revision/Review/Answers/Solutions 
Heading 4: Subsections 
 

 If the book is not divided into Parts / Units… 
Heading 1: Title of the Book 
Heading 2: Copyright / Preface / Foreword / Acknowledgements / Messages by Editor / About the Author / 
Contents / Index of words/Glossary/ Chapter Number & Name/ Worksheets/Revision/ Review/Answers/ 
Solutions 
Heading 3: Subsections 
Note: 
It is important that whatever system of level hierarchy is being followed should be followed for all volumes 
of a particular book. 
 
 

21. Ending Your Scanning & Editing Work 
 
When you finish your work for the session, at the end of the scanned or edited portion, mention that the 
document has been scanned / edited by you, and put down the page numbers that you scanned / edited 
during that particular session (based on the sighted print hard copy textbook, not the page number in the 
Word file). 
Example: 
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Scanned by ABC XYZ Pages 1-20 
Edited by ABC XYZ Pages 1 - 20 
 
Highlight this line in yellow so that it becomes easy to spot by the next volunteer who will continue where 
you stopped. 
 
Note: 
Even if you are the only one working on a particular book, following this process will help you locate where 
you had left off. 
 
How to adjust Line Spacing? 
i. In the Ribbon / Menu, go to the Home tab.  

ii. Under the Paragraph submenu, click on the  symbol i.e. the Paragraph dialog box option. 
iii. In the Spacing section, ensure that the Before and After values are 0; and the Line Spacing is Single. 
iv. Click on the OK button. 

 
 

22. Proofreading 
 
 Why & How? 
 
This step is setting proofing language. This ensures that it gets added to the book’s Metadata. 
i. In the Ribbon / Menu, go to the Review tab.  
ii. Under the Language submenu, click on Language and then Set Proofing Language as English (U.K.) 
iii. Click on the OK button. 
 
When you are proofreading the OCR scanned files it is important that you read the text like you would read 
a story book. EVERY WORD, EVERY LINE. 
Skim reading through the file for proofreading does not work for an OCR scanned file. As typical OCR 
scanning errors are sometimes as small as the scanner displaying 1 (one) instead of I (capital i). 
 
Also, as mentioned earlier, to spot this inaccuracy is by looking out for the errors recognised by MS Word 
itself. 
Whenever you notice a green or red wavy underline… 
i. Check the print book. 

ii. Position the cursor in the middle of the relevant word / phrase. 
iii. Right-click to look for correct options. 

OR 
i. In the Ribbon / Menu, go to the Review tab. 

ii. Under the Proofing submenu, click on the Spelling & Grammar option. 
 
Once the entire document has been edited as required, ensure that you remove all extra text that is 
mentioned for reference. 
Since statements like “Scanned by ABC XYZ Pages 1-20” and “Edited by ABC XYZ Pages 1 - 20” are no 
longer necessary, they must be removed before you can claim that the document is ready to be used as the 
Master Copy. 
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Conversion to the Braille Ready Word File, DAISY and EPUB 
After working on the Master Copy Word File, only a few changes would be needed to prepare the 
following: 

- Braille Ready Word File which can be used to create Braille books 
and 

- DAISY and EPUB which will be used with accessible screen reading software. 
*** 
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SECTION 2 – HANDOUT ON MATH & SCIENCE CONTENT CREATION 
 
This section covers accessible book creation for the following categories of books: 
 

A. Partially Technical Texts - A partially technical text is a Science book which utilizes a small number 
of Mathematical symbols. 

 In the accessible e-book and BRF word files for such texts, all mathematical expressions will 
appear as MathType expressions. OCR scanning for such books would be as per the 
scanning process discussed in section 1 of this handout. All Mathematical expressions 
would then be typed within the text manually with MathType as explained below.  

 In the Braille book for such texts, all mathematical expressions will appear as per the 
Nemeth Braille code, while the rest of the numbers and text would be as per the Literary 
Braille code. 
 

B. Technical Texts - A technical text is a work in the field of Mathematics, Physics or Chemistry. 

 In the accessible e-book and BRF word files for such text, all mathematical expressions will 
appear as MathType expressions. OCR scanning for such books would be as per the process 

outlined below and editing with MathType. 

 In the Braille book for such the texts, the entire file will appear as per the rules of the 
Nemeth Braille code. 

 

Handling Math Expressions & Symbols – in the Master Copy 
 

I. Hardcopy scanning (For Technical Texts) 
 
Additional Software Requirement for Scanning Math: 
- Scanner Software (Based on the scanner you are scanning from) 
- Infty Reader 
- MathType by Design Science 
 
Steps: 
Step 1. Image Scanning: 
Image Scan each page of the hardcopy textbook by selecting the following settings as shown in the 
images below; 

- Under “Everyday Scan” ensure that the following options are selected and then click on 
“More” 

Image Color Mode: Black/White 
File Type: BMP 
 
See image below. 

 
 

- Under “Images” section select “Resolution (ppi): 600 dpi” 
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See image below. 

 
 

Step 2. Naming the Image files: 
Ensure that each image file is named ONLY as shown below in the correct sequence. 
 

 
 
Note: These numbers in the file name may not correspond to the page numbers that appear in the 
hard copy book because each hardcopy page (cover page, contents, preface, publisher details, 
etc.) numbered or non-numbered will be scanned. 
 
Step 3. OCR scanning with Infty Reader: 
Optical Character Recognition, or OCR, is a technology that enables you to convert different types 
of documents, such as scanned paper documents, PDF files or images into editable and searchable 
data. 

 
A. Open all the scanned image files in InftyReader and choose the options as shown in the 

image below 
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B. Choose the options as shown in the image below and select “Start OCR” 
 

 
 
Step 4. Converting the Equations to MathType equations: 
Open the .xml file with MS Word and choose the option shown in the image below to convert the 
equations to MathType equations and wait. Ensure that the “Convert Equations” dialogue box 
shows the number of equations converted at the end. 
Avoid doing any other activity on the PC while the equations are being converted as the file tends 
to hang on doing so. 
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Step 5. Save as a .docx file: 
File > Save As > Save as Type: “Word Document (.docx)” 
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II. Inserting, Editing and Proofreading of Math Expressions & Symbols 

 
NOTE: 
Inserting MathType in Semi-Technical books 
Semi-Technical books here, refer to books other than Maths like Physics, Chemistry and Economics 
that have some level of or even little Math content in it. The equations appearing in these books, 
makes it a semi-technical book. 
For books like these too, MathType must be used for Math content. 
 
* Since adding a MathType Equation Editor Box, converts all numbers appearing in the book (even 
if that be outside the MathType Equation Editor Box) to Nemeth Braille (Braille code for encoding 
mathematical and scientific notation). Therefore it should be deleted before translating. Translate 
these equations separately and copy to word. Then copy to original DBT file adding one space 
before and after the equation. 

See Point 5 under Braille in Section 3  

 
All the sections for creating the Master copy file for literary books need to be followed for Math 
books as well, along with the additional points mentioned in this file. The exceptions to this are the 
following; 
Section I Point 1. Image scan. 
Section I Point 2. OCR scanning with Kurzweil 
Section II Point 4. Naming and Saving of Image Folder 
Section III Point 1. Copy Paste Unformat 
Section III Point 13. Handling Fill in the Blanks 
 
Caution: 
For any new kind of symbol you are typing or unsure of, please highlight that symbol yellow and 
check with the relevant staff or someone with a Mathematics background. A wrong symbol will 
give errors when transliterated to Braille that may get missed out when proofreading the Braille 
file & will be read out incorrectly by the screenreader. 

 
Software Requirement for Math Typing: 
- MathType 6.9 by Design Science (dessci.com) 
(Licensed version or the Free Lite version) 
 
Software Requirement for Reading Math Expression with Screen Readers: 
- MathType 6.9 by Design Science (dessci.com) 
(Licensed version or the Free Lite version) 
- MathPlayer by Design Science (dessci.com) 
This is a free software that runs in the background and enables NVDA to recognise the Math 
equations. 
- NVDA 2015.2 onwards (Non Visual Desktop Access) (nvaccess.org) 
This is a free open source software. 

 
The following are the steps to insert or edit Math Equations in the Word file: 
 
Method 1: 
- Go to the Start Menu and open “MathType” 
A MathType Equation Editor Window as shown below opens on your screen.  
- Type out the equation using the appropriate symbols, etc., from the MathType Equation Editor. 
- Copy-Paste these symbols to the Word file. 
Or 
Method 2: 
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While keeping the cursor in the position where you want the Math equation or symbol, press ‘Ctrl 
+ Alt + Q’ or select ‘Inline’ from the ‘Insert Equation’ section in the MathType menu ribbon in the 
Word file. 
A MathType Equation Editor dialog box opens on your screen. 
Type out the equation using the appropriate symbols etc. from the MathType Equation Editor 
Close and Save. 
 

 
 
 

 
 
Refer to the links to the following in ‘Additional Information’ for more information on working 
with MathType: 
https://www.dessci.com/en/company/training/misc/tipstricks-full.pdf 
https://www.dessci.com/en/dl/MathType5WinManual.pdf 
Or 
Method 3: 
- Double click on the MathType equation in the Word file 
- The MathType dialogue box containing the equation opens up 
- Edit the equation 
- Close and Save the dialogue box 
 
 
IMPORTANT NOTE: 
Do not use the methods shown below – or any other methods – to insert Math expressions and 
symbols in the Word file. 
 
- Do not Insert Math Symbols or Expressions directly from Word’s Insert Equation and Symbols 
feature shown below. 
 

MathType Equation Editor Box 

https://www.dessci.com/en/company/training/misc/tipstricks-full.pdf
https://www.dessci.com/en/dl/MathType5WinManual.pdf
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- Do not Insert Math Symbols or Expressions directly from the “Symbols” section on the MathType 
ribbon shown below. 
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Rules for Typing & Editing Math Equations 

 

The list appended below is important to follow because not following this process causes 
errors in the Braille file that are harder to spot and could also cause the equation to be 

read out or transliterated to Nemeth Braille wrongly. 
 

Rule #1. All Mathematical Expressions (i.e. not including plain numbers that are 
not a part of Math expressions) should be inserted with MathType. 
 
Here are some instances; 
Example 1: 
Plain numbers appearing throughout a book independently will not be Typed in MathType. 
Example: Ram bought 50 pencils. 
Here 50 is not typed in MathType. 
 
Example 2: 
Mathematical expressions in which all the symbols are available on the keyboard will also be typed 
in the MathType box. 

 
 
Example 3: 

 
 
Note: In the above equations the words ‘ones’ and ‘tens’ will be written in Style: Text and with a 
space before and after it. This is discussed in a later point. 
 
Example 4: 

 
 
Example 5: 

 
 

Example 6: 

 
 
Example 7: 

 

 
Example 8: 

 is incorrect cause ‘3x’ is not typed in MathType 
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 is correct, where the entire expression is typed in MathType 
 
Note: In the above equations the colon/ratio sign, the greater-than sign, the plus sign etc. are 
typed from the keyboard but in the MathType window. There is no special symbol for some 
symbols like ratio sign, plus, minus, greater-than, less-than etc. in the MathType window. These 
are typed directly from the keyboard. 
Signs of grouping (brackets) can be typed directly from the keyboard or can be selected directly 
from the options in the MathType window. 
 

 

Rule #2. You don’t have to type space within Mathematical expressions in the 
MathType window. 
 
Example: 
In the MathType window, when typing ‘y=’, you don't have to type a space between the y and the 
=, because MathType takes care of the spacing automatically. To help you break the habit of 
typing spaces, the spacebar is disabled most of the time in MathType, so pressing it will have no 
effect (other than producing a beep sound!).  
 

 

Rule #3. Using Styles in MathType. 
 
Note that the default style in the MathType window is ‘Math’. This is displayed at the bottom of 
the window as shown in the image below. 
 

 
 

For any text appearing within an equation type the text in MathType and choose “Style: 
Text”. 
Example 1: 

 
 
Here the style of the above text would need to be changed to ‘Text’ from ‘Math’. 
Hence select the word ‘Numerator’ and ‘Denominator’ and choose Style as ‘Text’ as shown below: 
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The corrected equation will appear like this –  

 
 
Example 2: 

10 1 (10)ones ten  

The default Style setting is ‘Math’ 
Select the words ‘ones’ and ‘ten’ and select Style: Text 
It will then appear like this: 

10ones 1ten(10)  

Press control space when keeping the cursor before ‘ones’, and before ‘ten’, and after ‘ten’. (This 
spacing is discussed again in a later point) 
The correct equation will appear like this: 

10ones 1ten(10)  

 
Example 3: 

Prob( ) Probability that   and  occur
Prob( | )

Prob(B) Probability that  occurs

A B A B
A B

B


 

both
 

 
Select ‘Prob’ and choose Style: Function 
Select the word ‘both’, and choose Other from the Style menu. The Other Style dialog box will 
appear, which lets you directly change the font and style (bold & italic) of selected characters. 
Click on Bold, and then choose OK. 
To get variables A and B in italics choose Math from the Style menu. This tells MathType to treat 
them as mathematical variables. 
 
Some other functions for which we select Style: Function are as follows: sin, cos, tan, cot, log, 
max, min, lim, etc. The whole list can be accessed under Preferences > Functions Recognized. 
 

 

Rule #4. Handling Bold & Italics in MathType. 
 
To bold the word ‘both’, as shown in example 3 for the previous rule, we chose Other from the 
Style menu. However Style: Other must only be used with text. Math Equations or Functions must 
not be shown in Bold using this style. Rather, follow the following: 
 
For the particular equation, go to Style > Define > Advanced and check all the boxes under 
Character Style – Bold/Italics and click on OK. Uncheck ‘Use for new equations’, to avoid carrying 
forward these settings to the next equations. 
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TO SUMMARISE: 

When Text is in Bold, use Style: Other (checkbox Bold) 
When Math content (symbols, variables, numbers etc.) is in Bold, use Style: Math, and then go to 
Define and check all boxes under Bold. Uncheck Use for new equations to get back to default 
settings in Define when done. 
Similarly, when Functions (sin, cos, tan etc.) are in Bold, use Style: Function, and then, go to Define 
and check all boxes under Bold. Uncheck Use for new equations to get back to default settings in 
Define when done. 
 
*Note: Bold & Italics do not appear in DBT. 
*Note: Another limitation is that you cannot bold only one of the words, numbers or symbols 
within the same Math 
 

 

Rule #5. The MathType Equation box in the Word file should be treated as you 
would treat a word with appropriated spacing before and after it. 
 
i.e. One space should be left before and after the MathType equation box at all times, except: 
- if the equation is followed by a punctuation mark. (since no space is kept before a punctuation 
mark at all times) 
or  
- if the equation is at the end of or start of a line. (since no space is given after the last word on a 
line or before the first word on the line) 
 
Example 1: 

(g) 

8
3

12  
A space will be given after ‘(g)’ and before the mixed fraction begins. 
 
Example 2: 

Is 

3 3
2 3

8 5


? 
A space will be given between the word ‘Is’ and the MathType expression, no space will be given 
between the MathType equation and ‘?’ 
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Rule #6. For text and punctuation marks within the MathType equations, spacing 
should be as per the rules of English. 
 
To type space within the MathType equation press “ctrl key + space bar”. 
Example 1: 
2 5 6 3

,  ,  ,  
7 7 7 7

 

One space is given after the comma. 
 
When percent sign follows a number, no space between the number and the sign. This is true also 
of all signs of punctuation. 
 

 

Rule #7. Handling Punctuation Marks within MathType equations 
 
When dealing with punctuation marks – comma, full stop, exclamation, etc., with the equations, 
note the following: 
- Spacing of punctuation marks should be as per Grammar rules, i.e. no space before them but one 
space after if followed by some text or equation. 
- When we change the Style of the punctuation mark to “Style: Text” we need to manually give 
space after the punctuation mark if we are typing anything ahead of it. 
(The spacing within equations is automated and correct only under Style: Math) 
- A punctuation within a Math expression should always be inside the MathType box with the 
style for that punctuation selected as “Style: Text” 
**The Full Stop/ Period is the exception to this rule. Keep the full stop outside the MathType box 
without any space before it, else it gets considered as a decimal point. 
 
Example 1: 

10 10 1,   

Here the comma is typed in the MathType window and the Style for the comma is selected as 
“Text”. 
And there is no space before the comma in the MathType window. 
 
Example 2: 

1 10
1 ?

6 8
  

Here the question mark is typed in the MathType window and the Style for the question mark is 
selected as “Text”. 
And there is no space before the question mark in the MathType window. 
 
Example 3: 

2 3 4, 3!   

Here the question mark is typed in the MathType window and the Style for the question mark is 
selected as “Text”. 
And there is no space before the question mark in the MathType window. 
 

(However when the exclamation mark is used to signify the Mathematical concept of factorials this 
should be left as Style: Math. In case you are unsure of the context in which the exclamation mark 
is used please check this with someone having a Math background.) 
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Rule #8. For Units of measurement (Rs., m, cm, l, ml, kg, etc) within MathType 
equations select the style as “Text” and give space before and after the units of 
measurement. 
 
Example: 

2m 3m  

 

 

Rule #9. For blanks within a MathType equation, type the question mark and not 3 
hyphens or 1 underscore. Here the question mark sign is left as “Style: Math” 
 

Example: 
2 _

1
3 9


 is wrong 
2

1
3 9


  is wrong 

2 ?
1

3 9
  is correct 

 

 

Rule #10. Symbols available on the keyboard (Decimal Point, Percentage Symbol, 
Greater than or less than sign) 
 
If a decimal number, a percentage symbol, greater than or less than sign etc. is not part of any 
Mathematical expression, it does not have to be typed in MathType. 
The full stop/period key on the keyboard can be used to type the decimal point.  
But if it is a part of any Mathematical expression, it has to be typed in MathType. The full stop/period 
and the percentage keys on the key board can be used to type the decimal point within MathType.  
Examples:  
> is the greater than sign. 
2.5 apples 
His Math score was 30%. 
The following equations too qualify as Mathematical expression - 

0.54   
5 5.0   
Note: A common error is using the dot multiplication from the MathType box for decimal. Please avoid 
doing this. Similarly, a dot multiplication sign is inaccurately put as a decimal point. This can be avoided 
by reading the book for context. 
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Rule #11. It is okay to type many equations in the same MathType window. 
However do not type full text sentences or phrases in the MathType window. 
 

Example 1: 
This is allowed; 
 

 
 
Avoid this: 

 
 

This is correct where only  and  is in MathType as shown below. 
 

The adjacent pair of angles whose sum is  is called a linear pair. Here  
 

 

Rule #12. Algebraic Variables and Names for Geometry figures that are a part of 
Math Equations need to be typed in MathType with the style left as “Math”. 
 
- Type in the MathType box and leave style as “Math” 
Example: 

 
 

 

Rule #13. When typing a single letter / variable that is not a part of a Math 
Equation it need not be typed within the MathType equation window. But, any 
two or more letters together need to be typed within MathType equations and left 
as “Style: Math”. 
 

Example; 

A and B are two points on segment . 
Here “A” and “B” are typed outside MathType. 
However “AB” is typed within MathType. 
 

 
Rule #14. When selecting superscript and subscript, in most cases we choose the 
first superscript / subscript symbol option. 
 



XRCVC's Accessible Book Production Standards 1.3 

 

 
 

 

Rule #15. Point your cursor to the symbol and check the symbol name at the 
bottom of the MathType window as shown below before inserting the symbol. 
 

 
 
Example: 

For the triangle symbol make sure to use the triangle – ( ) in MathType and not the symbol for 

Delta ( ) 
 

 

Rule #16. Underline numbers in MathType as shown below. Do not use the Word 
underline feature. 
 
Option 1 
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or 
 

Option 2 

 
 

 

Rule #17. Use the strikethrough option from the MathType window only as shown 
in the image below. 
 

 
 
Do not use the strikethrough option shown in the image below; 

 
 

 
Rule #18. Chemistry Structures and Equations 
 
Type 1 – Simple & Complex Chemical Structures 
For simple and complex chemical structures insert image and give appropriate alt text. 
Example 1: 
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Example 2: 

 
Example 3: 

 
Example 4: 

 
 
Type 2 – Chemical Equations 
All Chemical equations must be typed in MathType. The molecular formulae can be left as style Math 
within MathType. 
Example 1: 

4 2 3 3 2 4   CaSO Na CO CaCO Na SO  

Example 2: 

2 2( ) ( ) 2 ( )H g I g HI g  

 
Type 3 – Equations with Chemical Structures 
As in the examples below for equations with Chemical Structures and molecular formulae insert image of 
the entire equation and give appropriate alt text. 
Example 1: 

 
Example 2: 

 
 
Example 3:  
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Some More Shortcuts & How tos 
 

 1. Customizing the Toolbar 
The Toolbar can be customized to show symbols you use often in the licensed MathType version  
The expressions in MathType’s tabbed bars can be inserted into the equation you are working on 
with just a single click. 
To add your own expression to a bar, just drag it to the desired spot. 
To modify an equation on the bar, just double-click on it to open it in its own editing window. 
To delete an expression from the bar, right-click and choose Delete. 
 

 2. Keyboard shortcuts 
Quick Shortcut keystrokes when typing in the MathType window 
As you hold the mouse pointer over the palette items their name as well as the shortcut keystroke 
to access them is displayed in the status bar at the bottom of the MathType window. This will help 
ensure that you pick the correct template and remember the shortcut key to access them as well.  
Example: 
You can also create a superscript slot by typing Ctrl+H ("H" = "high").  
Ctrl+L inserts a subscript slot ("L" = "low"). 
Ctrl+F inserts the slot for typing a Fraction, and so on. 
Ctrl+Shift+E to change style to text 
Ctrl+9 for round brackets (parantheses) 
Ctrl+[ for square brackets 
Ctrl+R for radical sign (square root sign) 
Greek Characters: You can enter a Greek character using Ctrl+G and its equivalent letter, e.g. m for 

 , P for  , d for  . 

 

 3. Copying and Dragging 
To re-use part of an existing equation, select the part and then use Copy and Paste, or drag and 
drop. To copy the selection hold down the Ctrl key when dragging. 
 

 4. To type something like 
2

1C  
Keep the cursor before C, select the superscript slot, and type 2 in it. Next, keep the cursor after C, 
and select the subscript slot, and type 1. 
 

 5. To type most Spatial Math Sums 
To type all Spatial Math sums, Long Division sums etc. use the Matrices option in MathType as 
shown below. To create a matrix, use the ‘matrix templates,’ and select the variable-size matrix 
(shown below). This will allow one to create the matrix with as many rows and columns as needed. 
 

 
 
To obtain the horizontal and vertical lines in the Spatial Maths sums you need to follow the 
following steps:  
a) In the Mathtype go to Matrix templates and then click on Variable size matrix or table. 
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b) Insert the number of rows and columns as per your requirement and then click on the space in 
between the respective row/column in order to get the required line. 

c) Click OK. 
 

 
 
Example: 
The equation below was created using a 3 by 5 matrix, with the top two cells in Column one being 
unused. 

 
 

 6. Instructions to type Long Division sums 
A Long Division sum can be typed out in MathType using the fraction template as shown. 
 

 
 
You can use tabs for the Long Division sum underneath to line the numbers up. (The tabs are the 
arrows, of which the one used below is the one furthest to the left, to click and drag it along the 
ruler to the desired position.) Next, if you press ctrl + tab on the keyboard, it will bring the cursor 
to the desired position. 
How to use tabs is actually a course in the MathType help (Help > MathType tutorials). It can be 
found by using the index to search for ‘Formatting with tabs.’ 
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Also, to get the line underneath the “0” you will want to use the under-bar template, which is in 
row 2 column 6. Also, the line spacing will need to be lowered. It can be found in the ‘Format > 
Line Spacing’ menu. 

51

654 952

0

95

  

 
 
 7. To type Cross Multiplication 

Crop and insert image for sums with the cross multiplication symbol and add alt text to it. For example; 

 
 

 8. To Insert a Pascal Triangle 
1. Insert a matrix:  

 
 

2. Set the dimensions of the matrix as described below:

    # of 1s along a side 2 #s along the base  – 1 , which for this one is 5 rows, since there 

are 5 ones along the left or right side, and 11 columns, since there are 6 numbers along the 
base, so times 2 is 12, and minus 1 is 11. So what you see above is a 5x11 matrix. Before 
you close the Matrix dialog though, make sure Row Alignment is Baseline, Column 
Alignment is Center, and Equal Column Widths is checked. 
 

3. Type the numbers inside in whichever way it works for you, but I think a good technique is 
to start by typing a 1 in the bottom cell of the first column, proceeding diagonally up and to 
the right, typing 1 in each cell along that diagonal until you get to the top row. Proceed 
downward and to the right the same way. Now fill in the middle, skipping a column 
between each entry. 
 

4. When you're finished it won't look right – it will be way too spaced out. The one above 
looked like this at this point:  
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1

1 1

1 2 1

1 3 3 1

1 4 6 4 1

1 5 10 10 5 1

 

 
5. You can fix that in MathType by expanding the Format menu, and click the bottom entry: 

Define Spacing. You need to change 3 things in the Define Spacing dialog: 
Change Matrix row spacing to 100% 
Change Matrix column spacing to 1% 
Uncheck the box labeled Use for new equations. 
When you click OK, the triangle should look more normal. Like all templates in MathType, 
the green dashed rectangles are only to show you where the template slots are, and do not 
show up in Word. 

 
 9. To cancel many things together choose the option in the image as shown 

below; 

 
( )n x !

( )!n x 25
 

 

 10. To add Tally Marks 
Tally marks are inserted as vertical lines using the vertical bar on the keyboard "|" in the 
MathType box. Then use the strikethrough option as mentioned above. 
 

 11. Number above or below a cancelled number will be written as 
superscript or subscript numbers as shown below; 

11

15 5

3


1

11 1
1

2 10 10
   

 

 12. For expressions with large brackets use the brackets/parenthesis from 
the MathType (Ctrl + 9) and not the ones directly from the keyboard. 
Example: 

2 5 2 4
8 4  of 343 3 1 ?

9 7 3 5

 
    
 
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 13. To insert the Slanting Cross lines shown below 

Example: 

 
and 



XRCVC's Accessible Book Production Standards 1.3 

 

 
Note: It can be done in MathType, but it won’t be accessible. Hence we will create it as a graphic, 
and add the Alt text. 
 

 14. To Insert Circled Numbers 
Example: 

 
How to insert in MathType: 
For the circled numbers, the user would need to produce a circle and then nudge (move) the 
number inside it. MathType can use a circle from any font, so if there is a font on the computer 
that is being used containing a circle, that font can be used to produce it. Instead use the ‘Insert 
Symbol’ dialog, which is found in the ‘Edit’ drop down menu. Select ‘Insert Symbol,’ and then 
change the ‘View by:’ drop down menu to ‘Description.’ Click the ‘New search…’ button to search 
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for “circle”. The results will show up below, then click the desired circle and click ‘Insert.’ This will 
insert the circle into the MathType editor. 
 

 
 
Once the circle is in the MathType editor, it can be highlighted, and then clicked and dragged into 
an empty place on the MathType toolbar for future use. 

 
Once the circle is in the MathType editor, one can enter the number, size it (ctrl + > or ctrl + < ), 
and then nudge (move) the number into the circle. To nudge the number into the circle or 
highlight the number, and then hold the ctrl key, and press the directional arrow keys on the 
keyboard to nudge (move) it into place. 
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 15. To insert Long Division with the quotient to the left or Long Division to 
find the HCF 

Example: 

 
 
How to: 
Use the open or close parenthesis, or use the long division template available for the rounded long 
division signs after the number 55224 and before the 2. 
 

 
To achieve the line underneath the “110448,” use the “underbar template.” 
 
The tab functionality, which is explained in the MathType tutorial, i.e. the arrows directly above 
the workspace, is used to align the numbers. The arrows are to be dragged down to the ruler to be 
used. After a tab has been inserted, the ctrl + tab shortcut is to be used to tab over to the tab 
position. This is how the equation is aligned properly. 
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55224)122012 (2

110448  
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Handling Math Expressions & Symbols – in the E-Copy 
The E-copy remains the same as the Master copy. Nothing changes here. 
 

Handling Math Expressions & Symbols – in the Braille Ready 
Word File 

1. Handling Spatial Math Sums 
Let all spatial Math sums be in MathType as inserted in the Master copy. However add the 
following below the sum; 
- To represent the horizontal line for the answer: Below the MathType equation in the Word file 
type 3 ten times below the equation to represent the horizontal line where needed. 
Example: 

9, 9 9, 9 9 9

1

1 0, 0 0, 0 0 0

  

3333333333 
3333333333 
- To represent the horizontal line for carry over: If there is any kind of carry over in the sum type 7 
ten times above the equation. 
- For all other spatial Math (Long division, matrices etc.) leave them in MathType. 
 

Handling Math Expressions & Symbols – in the DBT file 
(Internally) 

 
1. Spatial Math Alignment (long division, cancellation with fractions, cross multiplication etc) & 

removing and adding braille symbols as required. 
2. Check & Correct spacing for Large Numbers that are written in the Indian place value system and 

that are a part of Math expressions. 
*** 
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SECTION 3 – HANDOUT FOR DAISY AND BRAILLE 
 

DAISY 
 
1. Naming 
Add Space DAISY to the file name after the existing name 
Example: 
Murphy, Raymond, Essential English Grammar, 2nd Edition, 1998, 69th Reprint, 2012 DAISY 
 
2. Page Numbers  
Remove 20 dashes and the word Page and heading level of page numbers. 
 
Remove 20 dashes and the word Page, this is done as follows: 

i. Copy the 20 hyphens, the word Page, as well as the space after that from any line with the page 
number, using Ctrl+C. 

ii. Press Ctrl+Home. 
iii. Press Ctrl+H to open the Find and Replace dialog box. 
iv. In the Find what: field, paste the 20 hyphens, the word Page, as well as the space 

(Page ), using Ctrl+V. 
v. Leave the Replace with: field blank (in order to replace the hyphens with nothing). 
vi. Click Replace All. 

 

*** 
 
 

Braille 
 
1. Naming 
Create a folder and name it as follows: Add Space BRF after the existing name 
Example: 
Essential English Grammar, 69th Reprint, 2012 BRF 
 
 
2. Saving and keeping files 

 All Literary and Maths books (of all levels) need to be divided into separate files volume wise. 
 
In the new BRF folder, create separate files for each volume 
Volume 1 will include: 
Copyright / Preface / Foreword / Acknowledgements / Messages by Editor / About the Author / Contents 
 
After creating Volume 1 as explained above, a separate volume is to be created for each of the following in the same 
order of the sighted print hard copy textbook: 
Chapter Number with Name / Index of words / Glossary / Worksheets / Revision / Review / Answers / Solutions or any 
other similar non-chaptered and non-numbered key sections in the book 
 
Name each volume as: 
… space Vol 1 
Example: 
Essential English Grammar, 69th Reprint, 2012 Vol 1 
 
 
3. Inserting Copyright Notice & cover page 
Insert the Braille Book copyright notice as whole for the first Braille volume each volume and add volume number in 
the same. 
For Braille volumes other than Volume 1, add only the Metadata and then after the sentence: 
For the Copyright and Disclaimer, please refer to Volume 1. 
 
e.g. 
Essential English Grammar 
Author: Murphy, Raymond 
Pages: 300 
ISBN: 978-8175960299 
Edition: First published in 2014 
Publisher: SAGE 
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Type of Book: Braille 
Division of book: 10 chapters 
Volume Number: 1 of 11 
 
 

4. To cut alt text and paste below the Image. 
When there is an image with alt text in the BRF file, before converting it to DBT make sure to cut the alt text 
from the image and paste it below the image. 
Example: 

 
 
In case of long Image Description 
 

 
 
 
5. Handling Tables 
(a) Aligning the Columns: 
For Match the Column… 
No change needed, unless it is a match the column having 3 or more columns: 
Master Copy Example: 

Subject Verb Object 

1. Gopal a. kept i. sad. 

2. The children b. has turned ii. quiet. 

3. The milk c. looks iii. sour. 
 
Braille Ready File Conversion: 
Copy-paste and place the contents of each column one below the other.  
The two columns are to be typed one below the other with titles as shown below.  
Example:  
Subject 
1. Gopal 
2. The children 
3. The milk  
 
Verb 
a. kept 
b. has turned 
c. looks 
 
Object 
i. sad. 
ii. quiet. 
iii. sour. 
 
For the Table of Contents… 



XRCVC's Accessible Book Production Standards 1.3 

 

Master Copy Example: 

 
 
Braille Ready File Conversion: 
    No change needed. 
 
If tables have more than four columns, or if the columns have headings, or if any cell has bullets & sub-bullets) 
Master Copy Example: 

Unit Comprehension Working with 
Words 

Learning 
about 
Language 

Listening and 
Speaking 

Composition / 
Activity 

1. Does He 
Remember
? 

An interesting story 

 Questions 

 Reference to 
context 

 Sentence 
completion
: words 
from the 
passage 

 Spelling: 
error 
correction 

 Collective 
nouns 

 Parts of 
speech 

 Word 
associatio
n  

 Punctuati
on 

 Listening 
comprehensio
n: marking a 
map 

 Writing a 
paragraph 
about the dog 
in the story 

Stopping by 
Woods on a 
Snowy 
Evening 

An insightful poem 

 Questions 

 Rhyme scheme 

 Reference to 
context 

  Functions 
of words: 
nouns 
and verbs 

 Tongue 
Twisters 
Long/short 
medial vowels 

 Creative piece: 
conjecture 

 
Braille Ready File Conversion: 
No change needed if table contains no MathType expressions. 
If the table contains MathType expressions it needs to be converted to plain text appropriately as per the example 
below: 
Example:  
 

x y x y  y x  x y y x    

4 3 4 3 7   3 4 7   4 3 3 4    

52 27 52 27 79   27 52 79   52 27 27 52    

0 28 0 28 28   28 0 28   0 28 28 0    

 

x: 4 
y: 3 

x y : 4 3 7   

y x : 3 4 7   

x y y x   : 4 3 3 4    
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x: 52 
y: 27 

x y : 52 27 79   

y x : 27 52 79   

x y y x   : 52 27 27 52    

 
x: 0 
y: 28 

x y : 0 28 28   

y x : 28 0 28   

x y y x   : 0 28 28 0    

 
 
(a) Editing the Questions 
In case of tables where the columns are going to be presented one below the other, edit the question as follows: 
 
Example: 
The words on the left all begin with the letter ‘boo’. Match each one with the correct meaning on the right. 
 
BRF copy: 
The words in Column A all begin with the letters 'boo'. Match each one with the correct meaning in Column B. 
 
 
(b) Blanks in Tables 
In case of blank cells in a table, leave the cell blank as it is. 
 
 
6. When working with a Semi-Technical book (Books having some Math content) 
All the equations in the book (which were added within the MathType box, must be checked manually. 
 
 
7. Notifying the end of Chapters / Volumes 
i. Press Ctrl+End to position your cursor at the end of the file. 
ii. Add 12 colons to represent the end of each volume (::::::::::::) 
 
 

*** 
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Master Copy (Math & Non-Math) – Check List 
 

Section 
No 

Section 
Heading 

Item No Item Name Task Applicable for Math Book 

I Scanning 1 Image Scan All pages with images except 
plain border 

Yes 

    Front and back covers Yes 

  2 OCR Scanning Complete Book: Cover to Cover NA 

II Saving & 
Keeping 
files 

1 Saving Book Save Book in the fixed location Yes 

  2 Naming the Book Folder and Files Author Surname, Author Name, 
Book Name, Edition Number, 
Year of the Edition 

Yes 

  3 Naming of OCR File Author Surname, Author Name, 
Book Name, Edition Number, 
Year of the Edition 

Yes 

  4 Naming and Saving of Image Folder Images Yes 
Folder Name: Images 
Image File Name: Image01, Image02 
etc. 

III Editing / 
Proofreadin
g / 
Formatting 
Stages 

1 Copy Paste Unformat Unformatted No 

    Font: Calibri 11 Yes 

    Left Aligned Yes 

  2 Cleaning up extra Spaces, Tabs, Enters etc. Switched on the Paragraph 
Mode 

Yes 

    Removed Unwanted Extra 
Spaces 

Yes 
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    Removed Unwanted Extra Tabs Yes 

    Removed Unwanted Extra Enters Yes 

    Line Spacing 0 Yes 

    Spelling and Grammar check Yes 

    Checked for appropriate Extra 
Lines for Chapter names, page 
numbers, pictures, tables, text 
box, section heading, 
subheading 

Yes 

  3 Inserting Copyright Notice & Cover Page  Insert the XRCVC Copyright 
Notice & Cover Page 

Yes 

    Cover Page with Alt text Inserted Yes 

  4 Inserting Page Numbers Added twenty “-“s with Page Yes 

    Checked for no space between -
Page  

Yes 

    Hindi Page Numbers added 
appropriately 

NA 

    Added Non Numbers Pages and 
cover page titles appropriately 

Yes 

  5 Handling Images Cropped Images Yes 

    Included Caption of images in 
the image 

Yes 

    inserted blank lines before and 
after 

Yes 

    placed images next to one 
another, one below the other 

Yes 

    Flow chart: as single images Yes 

    appropriate tag line for tactile 
diagrams, objects, activity 

Yes 

    Appropriate Alt Text Yes 

  6 Replacing Visual Words Replaced 
Tick/Colour/Circle/Underline/Cr
oss out 

Yes 
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    Replaced Fill in the box/grid Yes 

    Replaced fill in the words given 
in box/tree/cloud 

Yes 

    Replaced Draw line for match 
the columns 

Yes 

    Replaced trace over for cursive 
writing exercises 

Yes 

    Replaced: Refer words in colour  Yes 

  7 Handling Visual Marked Answers Replaced Visual marked 
Examples with writing the 
answers 

Yes 

  8 Retaining Visual Instructions Added Tactile Diagrams 
wherever applicable 

Yes 

  9 Additional Numbering Match the Columns Yes 

    Question without MCQs Yes 

    Questions with  MCQs Yes 

    Tree Diagrams Yes 

    Full stop and space for all 
numbering followed 

Yes 

  10 Multilevel Lists Placed Numbered lists one 
below the other 

Yes 

    Bulleted lists appropriately 
arranged 

Yes 

    MCQ Bulleted lists numbered Yes 

    MCQ non Bulleted appropriately 
arranged 

Yes 

  11 Handling Bullets and Sub Bullets two dashes for bullets Yes 

    1,2,3 numbering for sub bullets Yes 

    Numbers followed by full stop 
and space 

Yes 

  12 Handling Tables Inserted tables for contents 
section 

Yes 

    Inserted tables for sections 
required  

Yes 
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  13 Handling Fill in the Blanks three dashes for sentence blanks Not for blanks within equations 

    No dashes for table blanks Yes 

    single dash for single alphabet 
blanks 

Yes 

    No dashes for full line blanks Yes 

  14 Handling Text in Boxes 5 dashes before and after with 
Text box Begin; Text box end 

Yes 

  15 Handling Bold Italics Underline Applied Bold, Italics, Underlines Yes 

  16 Footnotes Inserted Footnotes Yes 

  17 Headings and Sub Headings Added Headings and Sub 
Headings  

Yes 

  18 Ending Scanning and Editing Work Added your ending work entry Yes 

  19 Proofreading Proofreading completed Yes 

 
 

Master Copy (Math Only) – Check List 
 

Section 
No 

Section Heading Item No Item Name Task 

I Scan Math 
Hardcopy Books 

1 Image Scanning Key Settings: 
Image Color Mode: Black/White 
File Type: BMP 
Resolution (ppi): 600 dpi 

  2 Naming the Image files Name files as image01, image02, image03 etc. 

  3 OCR scanning with InftyReader Open File & Choose "Start OCR" 

  4 Converting the Equations to MathType equations Use “Convert Equations” button from MathType in Word  

  5 Save as .docx  

II Inserting, Editing 
& Proofreading  
Math Expressions 
& Symbols 

1 Insert, Edit, Proofread Math Expressions Proofread & Edit MathType Equations following the 15 Rules 
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    Rule #1. All Mathematical Expressions (i.e. not including plain 
numbers that are not a part of Math expressions) should be 
inserted with MathType. 

    Rule #2: You don’t have to type space within Mathematical 
expressions in the MathType window. 

    Rule #3.  For any text appearing within an equations type the text 
in MathType and choose “Style: Text” 

    Rule #4. The MathType Equation box in the Word file should be 
treated as you would treat a word with appropriated spacing 
before and after it. 

    Rule #5. For text within the MathType equations spacing should 
be as per the rules of English. 

    Rule #6. Handling Punctuation Marks within MathType equations 

    Rule #7. For Units of measurement (m, cm, l, ml, kg, etc) within 
MathType equations select the style as “Text” and give space 
before and after the units of measurement. 

    Rule #8. For blanks within a MathType equation type the 
question mark and not 3 hyphens or 1 underscore. Here the 
question mark sign is left as “Style: Math” 

    Rule #9. It is okay to type many equations in the same MathType 
window. However do not type full text sentences or phrases in 
the MathType window. 

    Rule #10.  Algebraic Variables and Names for Geometry figures 
that are a part of Math Equations need to be typed in MathType 
with the style left as “Math”. 

    Rule #11.  When typing a single letter / variable that is not a part 
of a Math Equations it need not be typed within the MathType 
equation window. But any two or more letters together need to 
be typed within MathType equations and left as “Style: Math”. 

    Rule #12. When selecting superscript and subscript in most cases 
we choose the first superscript / subscript symbol option. 
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    Rule #13. Point your cursor to the symbol and check the symbol 
name at the bottom of the MathType window as shown below 
before inserting the symbol. 

    Rule #14. Underline numbers in MathType as shown and not 
using the Word underline feature. 

    Rule #15. Use the strikethrough option from the MathType 
window as explained in the handout only 

 
 

Braille Ready File – Check List 
 

Section 
No 

Section Heading Item 
No 

Item Name Task Applicable for Math 
Book 

II Saving & Keeping 
files 

1 Saving Book Created a folder and Separated Volume files in the folder Yes 

  2 Naming the Book Folder Added Space BRF to the folder name after the existing 
name 

Yes 

    Added Volume Numbers to each volume file Yes 

  3 Naming of OCR File NA  

  4 Naming and Saving of Image Folder NA  

III Editing / 
Proofreading / 
Formatting Stages 

3 Inserting Copyright Notice & Cover 
Page  

Inserted the Braille copyright notice for each volume and 
added the specific volume numbers 

Yes 

    Added 12 : at the end of the volume :::::::::::: Yes 

  12 Handling tables made appropriate changes Yes 

      

Additional Points for Maths - Braille Ready File   

   Handling Spatial Math Sums Type the number 3 ten times (to look like 3333333333) for the horizontal lines 
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    Type the number 7 ten times (to look like 7777777777) 
when the sum has numbers carried over 

 

   Handling Tables For tables that contain MathType expressions do not use 
tables, but manually break them up appropriately in the 
BRF word file 

 

Additional Points for Maths - DBT Soft Copy   

   Spatial Math Alignment  (Long division, cross multiplication etc.) & removing and 
adding braille symbols as required. 

 

   Large Numbers in Indian place 
value system 

Check & Correct spacing for Large Numbers that are 
written in the Indian place value system and that are a 
part of Math expressions. 

 

 
 

DAISY – Check List 
 

Section 
No 

Section Heading Item No Item Name Task 

II Saving & Keeping 
files 

1 Saving Book NA 

  2 Naming the Book Folder Added Space DAISY to the file and folder name after the existing 
name 

  3 Naming of OCR File NA 

  4 Naming and Saving of Image Folder NA 

III Editing / 
Proofreading / 
Formatting Stages 

4 Inserting Page Numbers Remove 20 hyphens and the word Page (use Ctrl + H) 

    Remove Heading Level for Page No. 

 

~ The End ~ 
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